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To Use the Front Panel

You can use the dedicated, front-panel knobs and buttons to do the most common operations.

Turn INTENSITY to adjust waveform intensity.

Push FastAcq to turn Fast Acquisition
on and off.

Push CURSORS to turn cursors on and off.

Push PRINT to make a hard copy.

Push DEFAULT SETUP to return settings to the
factory default values.

Push AUTOSET to automatically set the vertical,

horizontal, and trigger controls to produce a
usable display.

Use the multipurpose knobs to control ——
parameters selected from the screen interface.
Push a FINE button to make small changes with
a multipurpose knob.

Push OFF to turn the optional touch
screen on and off.

Push ZOOM to add a magnified graticule to the

display. Push the HORIZ or VERT button to
select the axis that you want to magnify.

Use these knobs and buttons to set horizontal

SCALE and POSITION for the waveforms. Push
DELAY to turn on horizontal delay, and then use
POSITION to set the delay time. Adjust
RESOLUTION to change the number of acquired
points in the waveform.

Use these knobs and buttons to set the basic

trigger parameters. Push ADVANCED to display
a menu of additional trigger functions.

Use these buttons to start and stop

acquisition or start a single acquisition
sequence. The ARM, READY, and TRIG'D
lights show the acquisition status.

Push CH<X> to turn channel displays on and off. —»--
Adjust the channel POSITION and SCALE or
change the input termination with dedicated

knobs and buttons.
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To Use the Screen Interface

You can control all oscilloscope functions, including powering off the instrument, through the screen interface.

Choose the Toolbar

Click here to change to menu-bar operation.

Click a button in the toolbar to display a —
control window at the bottom of the display.

Click a screen control to change a setting.

Click a numerical control to assign that control
to a multipurpose knob. Turn the multipurpose
knob to adjust the parameter value.

Or Choose the Menu Bar
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Sample

Fun

GCh1 Position
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Ch1 Scale

Chan 1

Display

Vertical Zoom Offset

Use some menu items to display a control
window at the bottom or side of the display.

Ch1 Positio

Sulosst
2.6div

Fast Acquisitions

Ch1 Scale

50.0mY

Bun/Stop...

Delay Mode On
Roll Mode Auto

Use some menu items to directly
change settings.

Equivalent Time Auto

Resalution.
Acguisition Mode.

Zoom Setup.

Click here to change to toolbar operation.

Chi

B0.0m Y

Click here to close a control window.
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More Operating Tips:

m  Use the optional touch screen to control the oscilloscope when bench space is
unavailable, such as on a cart or in an equipment rack.

Plug in a mouse and keyboard if you have the bench space to use them. You can
plug in a USB mouse or keyboard anytime, even while the oscilloscope is
running.

Use the menu bar to access PC-related functions such as, Page Setup, Export,
and Copy.



To Display a Waveform

Attach a probe to CH 1 and connect the probe { (sronys )
to your signal.
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Adjust VERTICAL and HORIZONTAL 4 < ~ - ~ - ~ - ~ @p
POSITION and SCALE if necessary to SCALE SCALE SCALE SCALE
optimize the display. @ @ @ @
~
& J
Adjust RESOLUTION to change the record  §
length and sample rate. You can acquire
more samples in the waveform to see more
detail, or acquire fewer samples with a
faster update rate.
Adjust INTENSITY to change the brightness, 6
vector fill, and display persistence of acquired
points.
Recommended Probe
Accessories
P5050 Passive Probes for P6243 and P6245 Active Probes or P6158
general-purpose applications Low-C Probe for high-speed applications

P6246, P6247, P6248 Differential Probes TCP202 Current Probe for
for differential signals and low-noise general-purpose applications
applications
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To See More Waveform Detail

Use Zoom Use the Zoom function to magnify an acquisition vertically, horizontally, or in both
waveform dimensions. SCALE or POSITION changes you make to the Zoom graticule
affect only the display, not the actual waveform that is acquired.

ZOOM

Push the ZOOM button to splitthe
screen and add a zoom graticule.

Push the HORIZ button or the VERT buttonto 9
select the axis you want to magnify in the zoom
graticule. Use the multipurpose knobs to adjust

scale and position of the magnified waveform.

Main graticule Zoom graticule

You can also set up a zoom graticule

from the screen interface. Click and drag
across the segment of the waveform that
you want to see in greater detail.

it us 2 56515
et o v

Then select Zoom from the drop-down list to
magnify the highlighted waveform segment.

) % A
N
1»@“}

Use Horizontal De|ay Use horizontal DELAY to acquire waveform detail in a region that is separated from
the trigger location by a significant interval of time.

Trlgg<1r point |<— Acquired waveform 4»]
Y
Eainipipipipipijjigigigiin
|
| |
f«— Delaytime ——— >

——HORIZONTAL ——= T _
POSITION Expansion point

Push the front-panel DELAY button. 1 ——(oeav) @

/HE(SOLUTION

Adjust the delay time with the horizontal 2 ——

POSITION control, or enter the delay time zoou @
in the control window. ) shPEs
<| SCALE >

Adjust the horizontal SCALE to acquire 3§ —

the detail you need around the delay
expansion point.

More Operating Tips:

®m  You can use Zoom and Horizontal Delay together to magnify a delayed
acquisition.

m  Toggle Horizontal Delay on and off to quickly compare signal details at two

different areas of interest, one near the trigger location and the other centered at
the delay time.
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To Use Fast Acquisition
Turn Fast Acquisition on to acquire up to 100,000 waveforms per second.

Horizdteq  Ing  Display Coe

Horizontalcquizition Setup...

INTENSITY Zoom Controls...

Push the front-panel FastAcq button. { —= @
“TRIGGER———

Autozet

Or select Fast Acquisitions in the

oD
Horiz/Acq menu. @ [—@ N Bun/Stop...
Delay Mode On

v Foll Mode Auto
v Equivalent Time Auto

PBosition/Scale...

Resalution...
Adjust INTENSITY to optimize the intensity or 2 Acguisiton Mode..
color grading for the signal you want to analyze. Zoom Setup..
Increasing intensity can make less-frequently
acquired points brighter in the display.
Ele  Edit Metical  lenzftcg Tig  Display  Cuwsois Measwe  Math Lilties  Help

02 Mar 00 11.50:10 @-

Ch1 Position

-1.8diy |

How DPOs Work

Unlike DSOs that have long dead times between
acquisitions, Digital Phosphor Oscilloscopes
(DPOs) continuously acquire waveforms at rates
comparable to analog oscilloscopes. DPOs
continuously overlay the acquired information
into a three-dimensional database that is
updated on the display 30 times per second. For
each pixel in the display, the intensity (or color)
of the pixel is proportional to the number of
actual samples that the pixel represents.

Ch1l Scale
anmy |

Ch1  400m ¥

Analog Real Time sweeps ——— A
Digital Storage acquisitons ———> N
Digital Phosphor acquisitions ——— A

N J
Y

il

More Operating Tips:

m Choose one of the color grading palettes in the Display Colors control window to
see different sample densities represented in different colors.

®  Turn AutoBright on in the Display Appearance control window. When you use

AutoBright, the displayed waveforms remain visible even at low trigger repetition
rates.
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To Choose an Acquisition Mode

Honzfteg  Trig  Display  Cur
Horizontal AAcquisition Setup... — I

Zoom Contrals....

Autoset Harizantal

East Acquistions Acquisition Mode
Bun/5top... Sample Pk Detect Hi Res

Select Acquisition Mode...inthe 1 — —loo Mode O I I
onee 1) oo ES EEN ExN

Resoluti

v Foll Mode Auto
. v Equivalent Time Auto derage Errvelope
Or click the Horiz button, and then select Bosiion/Sedle.. | -
an acquisition mode in the
|

horizontal/acquisition control window.

Zoom Setup... # of Wims
16

For Average or Envelope acquisition modes, 2
click the # of Wfms control and then set the
number of waveforms with the multipurpose
knob. You can also double-click the control and
use the pop-up keypad.

record duration Displayed record points (at

How the Acquisition acquisition interval = - o points in record maximum horizontal magnification)
Modes Work . A §
Interval 1 2 3 4 Interval 1 2 3 4
Sample mode retains one sampled point from R; 7777777 ? A7 -
each acquisition interval. ~— e N Sample e :.— ——e

fffffffffff B
Peak Detect mode uses the highest and ﬂ ™ T ¢
lowest of all the samples contained in two \/‘ Ny m

consecutive acquisition intervals. I/ . | PeakDetect | =~ . | .

Hi Res mode calculates the average of all Kf R e -

the samples for each acquisition interval. e e HiRes |———f——¢— 1 —o

Three acquisitions from one source
A

p
Acquisition 1 2 3
Envelope mode finds highest and lowest record m

points over many acquisitions. Envelope uses
Peak Detect for each individual acquisition. Envelope

Average mode calculates the average value for
each record point over many acquisitions. m m m Average

Average uses Sample mode for each individual
acquisition.

l

.
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To Select a Trigger

IC——TRIGGER—D™ Trig Display  Cursors  Meagure
N A Event [Main] Trigger Setup..
' Duick Select 4
SOURCE COUPLING SLOPE Edge Setup
Glitch Setup.
o) (CE) NEGL LR
Select the EDGE trigger type and then set the —— - TS
source, coupling, slope and mode with these Selup/Hold Seup
front-panel controls. Push ADVANCED to select - Lo
one of the other trigger types. & @™ pust 05k 0% ko Setup
e = & R
Holdaff
You can also select a trigger type in the Hode
Trigger menu pote
. . - A:Edge — Acnuire
Or click the Trig button and then selecta — "7 R —
trigger type in the trigger control window " S

that is displayed.

Coupling

v

Hald
Slope Force Trigger
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Trigger Selections

Trigger type Levels Timers Trigger conditions
Edge Single level None Trigger on rising or falling edge, as defined by slope
/? control. Coupling choices are DC, AC, AC LF Reject, AC
_ HF Reject, and Noise Reject.
Video Single level None Trigger on NTSC, PAL, SECAM, Analog HDTV, and
'u*h' Custom video formats.
Glitch Single level One to specify glitch Trigger on glitches narrower than the specified width or
j_\l—.“? width ignore glitches narrower than the specified width.
Width - Single level Two to specify minimum Trigger on pulses that have widths between the range of
- \ and maximum pulse the two timers or outside the range of the two timers.
Runt Two levels to define the One to specify an Trigger on a pulse that enters the transition region from
logic transition region optional minimum one side but does not leave the region from the other side.
runt-pulse duration Pulses can be qualified with the logical states of other
channels (4-channel models only).
Window Two levels to define One to specify an Trigger when a signal violates either upper or lower
J_|_|_|_r signal transition region optional minimum boundaries set outside the normal range of the signal.
violation width Events can be qualified with the logical states of other
channels (4-channel models only).
Timeout Single level One to specify time-out Trigger when a signal does not make a transition for a
k time specified length of time.
Transition — Two levels to define the One to specify transition Trigger when a logic signal spends more time or less time
1 logic transition region time in the transition region than a specified amount of time.
= e

Setup/Hold o

Independent levels for
Data and Clock

One to specify setup
time and one to specify
hold time

Trigger on violations of setup or hold time between a Data
signal and a Clock signal. The specified setup and hold
times can be positive or negative values.

State ﬂ

each channel

Pattern Independent levels for One to specify pattern Trigger when a Boolean combination of up to four
%} each channel duration channels becomes true. Trigger immediately or only after
the combination is true for a specified time duration.
Independent levels for None Trigger on transition of one channel when a Boolean

combination of up to three other channels is true.
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To Use A (Main) and B (Delayed) Triggers

You can use the A Event (Main) trigger alone or combine it with the B Event (Delayed) trigger to capture more complex signals.

Set the A trigger type and source inthe  q
A Event (Main) tab of the trigger control

window.
B Event Mode f:Edge — Trigger After Time — BiEwent — fcquire
A-=B Sequence Horizontal & Evart Position
& Only (DGl LB 50,0
B Trig Level
0.0
Trin After i
Choose a function in the A—B Sequence tab of 2 Liss ' Trig Delay
the trigger control window. | As 16.0ms
Set the trigger delay time or the number
of B events, as appropriate.
Set the B trigger characteristics in the B Event 4 — g
(Delayed) tab of the trigger control window.
Pretrigger Posttrigger
record record
Trigger on B Event Atrigger point — Ac?uired waveform record ———>]
The A trigger arms the oscilloscope. A;gggg ! I
Posttrigger acquisition starts on nth B event. I
source . . y . .
Waiting for nth B trigger point
event (Where n=5)
B Trigger After Delay Time Atrigger point -
The A trigger arms the oscilloscope. A trigger \MWW_UW
Posttrigger acquisition starts on the first B source | I I

edge after the trigger delay time.
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B tigger _f\_k_[\J\J\J\J\J\\J\J\J\J\
source |<_ Trigger _.|

delay time B trigger point

More Operating Tips:

m  B-trigger delay time and horizontal delay time are independent functions. When
you establish a trigger condition using either the A trigger alone or the A and B
triggers together, you can also use horizontal delay to delay the acquisition by an
additional amount.

= When using the B trigger, the A trigger can be any of the following types: Edge,
Glitch, or Width. The B trigger type is always Edge type.



To Take Measurements with Cursors

Push the front-panel CURSORS button. Gursor Source

Ch [Math = Ref

Channel

Jf°

Select the waveform you want to measure and 2
a cursor type in the cursor control window.

Or you can activate cursors on the selected Cursor Type
! waveform directly in the Cursor menu N ilEer, el

Curzar Controls...

v Curzors On Split
& H-bars
M B3
Curzor Position... Eal.red
Split

Setup Close

Cursor Setup..

Cursor Positions

Curs1 Pos Curs? Pos

Place cursors with the multipurpose 3 6.0 3

knobs or enter the cursor locations
numerica”y_ Cursor 1 Source Cursor 2 Source

Ch  |klath{f Fef Ch [kath | Ref

Channel Zhannel

If you choose split cursors to take 4
measurements between waveforms,
select the source for each cursor.

T1: 356.4 ms

T2: 352.5 ms

AT: 3.92 ms

1/AT: 255 Hz

V1:5.120V

V2: 4.886 V

AV: 234 mV
AV/AT: 59.7 Vis

|

Read cursor measurement §
results in the display.

Other Cursor Measurement Tips:

® You can set the cursors to move together in tandem if you choose the Tracking
cursor mode. The cursors move independently if you choose the Independent
cursor mode.

m |f you use the zoom graticule, you can place a cursor directly on a specific
waveform point to take precision measurements.

®  You can also move cursors by dragging them to a new position.
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To Take Automated Measurements

Click the Meas button, and then select up to ——
eight measurements using the measurement
control window.

Source

Measurements

Mean
Fk-Pk

Freq

Setup

Chi
Chi

Chi Gating

Use the tabs to access measurements in
four different categories.

Measurement Setup...

Measure  Math  Utilities  Help

Snhapzhat...
Amplitude High Lewvel
Timne 4 Lo Level
karg 3 Amplitude
b E5irnumn
Dizplay Statisti » "
izplay Statistics Mirirmum

oo | cnlle

Or choose a measurement for the selected
waveform directly in the Measure menu.

Gating...

Foz Overzhoot !

gl
Rise Time |Chi

Delay

Rise Time | Ch2

Display

shot

I

hivanced

Meg Oyershoot
Waveform Hiztograms. . tean
Reset Histogram RS
Histogran Measurements  # Cyele Mean
Cycle RS
Automated Measurement Selections
Amplitude Time More Histogram (Option 2A)
. Positive . o Burst Wfm Std
High Mean Overshoot Period Rise Time Delay Width Count Max Deviation
2L Negati S U e Positive A @ Lk
Low Overshoot | T7e4Hency | FallTime Duty Cycle Phase H|Btcs)):n Min utto
Max Amplitud Positive Negative Negative Area Peak Pk-Pk
mpituce AMS Width Width Duty Cycle Hits H+20
Min ,\C,I)égﬁ %{;lse Cycle Area Median Mean u+30
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To Customize an Automated Measurement

Use Gating to confine the measurement —— » ,rh
to a certain portion of the waveform. “ []

Turn on measurement statistics to
characterize the stability of the measurement.

High Ref Measuremnen
Period
Pos Width : 111. MNeg Width
L. Burst W
. - Rise Time Fall Time
Adjust the measurement reference levels to - * Duty Cyc - Duty Cre

different relative or different fixed values. : e
Amnlilrtli';
Mean
RMS Gycle RMS
Cyc Area : 2l

Select snapshot to see a one-time
view of all valid measurements.

To Set Up a Histogram (Option 2A)

I

Drag across the segment of the waveformthat { ———] 1 \\ R R
you want the histogram to cover. To set up a Z :
horizontal histogram, for example, make the i o G

box wider than it is tall. el
Histonfram OFf

Meaz|rement Gating Off

Canc||

Select Histogram from the drop-down list. 9

Trg  Display  Cursors

View the histogram at the top or edge of
the graticule.

|f yOU need '[0 make any ad]UStmen'[S Waveform Histogram o LT
i i i i - Display
to the histogram, use the histogram Source Histogram - Histogram P
setup control window. o i

Bottom Lim

A60.0mY

Take automated measurements on histogram § e Adjust
i H 1 Histogram Box
data. See previous page for information. e T Linis - Logatinn
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To Use Standard Math Waveforms

Math  Uhlties  Help

Select Math Setup in the Math menu. {1 —  Math Setup...

Dizplay OnAOF...
Position/Scale. .
Label...

Dizplay OnAOFF..
Position/Scale. .
Label...

I agnitude Spectrum

Choose the math equation that you wantto 2 Math1 [ Mathz || Math3 | Mathd

define. (In this example, it is Math 1.) -

Display Position ; Dual Waveform Math

-420midiy | . y 2 Source

ChiWw
Scale
| Linear ¥ B =
E Cancel
Window
Type

| Hanning

Close

Select a waveform, an operator,anda 3
waveform to build your waveform expression. In
this example, Math 1 is defined as Channel 1
minus Channel 2.

Use the Apply button to create the math 4
waveform after defining your math expression.

Use the Source, Scale, and Window Type FFT §
functions to analyze the frequency components
of your signal.
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To Use Advanced Math Waveforms (Option 2A)

Math  Utiities  Help

Select Math Setup in the Math menu. {1 —=

Dizplay On/0ff...
Poasition/Scale. ..
Label...

Ch1 -Ch2
Ch3 - Chd
Ch1 * Ch2
Ch3 * Chd

Choose a predefined math espression. 2 Setie Bohi

IMath 1 Math 3 | Math 4
Math1

Define/Edit Expression

Display

Editor s
Predefined Expression

Label

M agnitude Spectrum
Phaze Spectrum
Spectral Contrals...

Set Math Averages

Equation Editar...

Or click Editor to define a more advanced math
waveform. Then build the waveform expression
using sources, operators, constants,
measurements, and functions. e B

Tert Log 10

Loge

To Use Spectral Analysis

Choose Spectral Analysis to define FFT
magnitude and phase waveforms. When an
FFT waveform is selected, you can use the
multipurpose knobs to adjust the FFT waveform
just as you would on a spectrum analyzer.

Freq Span #
5 omHz | T®

Res BW
5.0kHZ

Ref Level
20.04B

Setun Close

Operands

Ch [Math Ref n n

Cancel

0k

~—— Adjust FFT center
frequency

You can view time-domain and
frequency-domain waveforms
simultaneously. You can also use

gating to select only a portion of the
time-domain waveform for spectral

analysis.
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To Store Information

Horizdécq  Trig Displap Cu

To Save and Recall Waveforms S

I Refs I

Rieference Setup...

To save or recall waveforms, select { — = feeeerese. Dl Ol
Fecall Default Setup Pozition/Scale...
Reference Waveforms and then Save Wfm... or o Acolont | Label.
unAaoolcation

Recall Wfm... in the File menu.

Page Setup... Recall Wm..

Or click the Refs button.

Use the reference setup control window to copy
a live waveform into one of four nonvolatile — — : Save Wim to Refl Recall Ref1 from File
reference waveform storage locations. You can : ' Ch I . e

also display these waveforms as reference

i o - D Fecall
waveforms. Vert Scale E

1.0 a m Save Wim to File Delete Wim File
A el i

vl 4 c % o

. Horiz Position

Select Save Wfm to File to store the live
waveform as a file on a disk drive. You can
recall a waveform stored on disk into one of the
internal reference waveform locations for
display.

To Save and Recall Instrument
Setups File  Edit  Mertical Horizdte @

Reference 'Waveforms »

Irvstruimy .

To save an instrument setup, select {1 — 1 .
Fiecall Default Setup

Instrument Setup in the File menu.

Run Application 3

Or click the Setups button. o

Save Settings from Local Memory
Save Settings

Use the settings control window to save the 5 Check “ Wirite Strobe n Factory to File
current setup into one of ten internal storage
locations. Use the pop-up keyboard to label the ST T e (2
setups for easy identification. o e N - Fecon B - Fecton
Or select Save Settings to File to store the S TTHE P
current setup on a disk drive. You can recall any

setup stored on disk and then save it in an Data Bus Factory
internal setup storage location for faster access.

To restore the oscilloscope to a known initial 3 — Flo | Edt  Wericsl  Horz/he
state, push the front-panel DEFAULT SETUP Beference Waveforms v
button Instrument Setup...
Or select Recall Default Setup in the File menu. Run Application ’
Pane Setun
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To Print a Hard Copy

To print a hard copy to the internal
printer, an attached printer, or a
network printer, push the
front-panel PRINT button or select
Print in the File menu.

File  Edit  ‘ertical

Beference waveforms

—> Instrument Setup...

Recall Default Setup

Harizdde

Fun Application

Page Setup...
PFrint Preview

If necessary, you can make — .|

changes to the page orientation in
the Page Setup dialog box. Choose
Screen-copy to print basic
screenshots or Banner to print long,
continuous-feed waveforms.

The Page Setup dialog box also includes ——-

selectors for the print palette and a feature
called Ink Saver. Ink Saver optimizes the
display colors and shades for printing hard
copies on white paper.

To Export Your Results

You can use the Windows clipboard to —
copy information. Simply select the item
to copy, copy it, and then paste it into
another Windows application.

Furart Sabin

Tvpe of printing

™ Screen-copy

{* Banner

Falette———— View Image

& Color & Full-Screen = Momal

" GrapScale " Graticule[z] Only || © Ink-zaver Mode
" Black & white

Edit  Wertical Honzdéeq  Tng  Display  Curs

LCopy Chrl+C

Select for Copy

k| ® Full Screen [bitmap)

Graticule [bitmap] \
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You can export waveform data into a » —1420379613,-1400249222, -1407839845, -1415300200,

comma-separated ASCII file for use in a
spreadsheet or data analysis program. Select
Export Setup in the File menu to set the output
content and format for images, waveforms, or
measurements.
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—-14226295596, -1429527356, -1436592513, - 1443825313,
—-1479636700,-14572855891, -1463518722, -1529021630,
—-15207655593,-15415896902, -1458577715, - 14594424516,
—-1500133037,-1505702749,-15111331559,-151642370&,
—-1521573950,-15265853406,-1531451606,-1536178099,
—-1540762450,-1545204233, -1549503037, -1553 658465,
—-1557670132,-15615357666,-1565260711, -15688385922,
—-1572271966,-15755559525, -1578701302, -15516965995,




To Run Application Software

You can install and run optional application software on your oscilloscope. These software packages provide advanced capability
supporting many applications. Two examples are shown below; additional packages may be available. Contact your Tektronix
representative for more information.

o e L ]

Lo

W40 0ns 5068/ 00s.
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Use TDSJIT2 Jmer Ana|ysis Software to &  Measurements Inputs Resulls Analysis Plots Log

characterize timing performance. Analyze jitter (o (0
on contiguous clock cycles using single-shot
acquisitions.

Fle Edt Verical  Hoeficq Trg  Display  Cusors  Measwe  Math  Utiiies  Help
Tek __Fun I 01 tar 26.0,

. BlmYQ R . . M200ns 2565/ Y L0l 4n0ps.

Use TDSDDM2 D|Sk Drlve Measurement il ure;nems Inputs  View P|Ut‘ Log Help .
Software to measure disk drive signals
according to IDEMA standards.

Input Channels Trigger

Read Signal Sector Pulse Start Sect

chi ¥ cha v

Read Gate Index Pulse Preamble  ®  Stop Sector ¢
e

= L =
chz v cha ¥ 1 = i)

File ~ Edit  Wertical Honzddeq  Trg  Display  Cursors b

Reference Wavetorms 3
Instrument Setup...
Recall Default Setup

Follow the instructions provided with the ——— AR

application software to install it. To run
the software, select the application in the
File / Run Application menu.

Page Setup...
Frint Frexview
Frint... Chrl+P

Export Setup...
Select for Export 3
Export...

1 BecentSetum Eile

Mirimize

Shutdaown...
Exit
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To Connect to a Network

Like any other Windows computer, you can
connect the oscilloscope to a network to enable 7 S~
printing, file sharing, internet access, and other = =

communications functions. I I /
Network

To make a network connection, consult with
your network administrator, and then use the
standard Windows utilities to configure the
oscilloscope for compatibility with your network.

O‘o
o oo 00
© mide

00000000
00 00000

@
om0

9

To Use a Dual Monitor

Connect a keyboard, mouse, and monitor to the
oscilloscope and configure Windows for
dual-monitor mode. You can operate the
oscilloscope while having full use of Windows
and other installed applications on the external
monitor.
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Connect the monitor to the upper SVGA port on
the oscilloscope side panel. Use the Settings
tab in the Windows Display Properties dialog

box to set up a dual-monitor configuration.
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To Access the Help System

Utiities | Help

Help Topics| Back | Options | Clove [ Hinimie

Click the HELP button or select Help on
Window in the Help menu to receive

Offset
Overview Y Display ) PosionkSeale Y Offset

LContentz and Indes...

context-sensitive help on the current setup. el

L] Touse

b Use the Vertical Offset controls to set the offset value of the selected
"waVETI to Shift the vertical acquistion wincov to match the wavetorm
deta you wart to acouire

Click & chanrel t the top of the control window to select the vertical inpt channsl. Click the Offset

Specifications...
Technical Suppart....

Customer Feedback. .. control to map it ta one of the multipurpose knobs and use the knob to set the offset value
Behavior
About Scope.. Use the ofiset control to eliminate clioping the waverorm. The offset cortral affects the vertical

acguistion window by subtracting & DC bias from the wavetorm. This moves the level st the vertical
center of the acouisition window of the selected channel. Visuslize offset s scroling the
acoisttion window towards the top of a large signal for increased offset values and scroling

towvards the hottom for decreased offset values
The offzet contral affects the waveform display by defining the channel reference indicator to
matich the offset rather than the ground level. The offset attects only channel waveforms as

compared to the position control that affects all wawsforms, including math and reference
wavefarms.

‘What do you want to do next?

Jcontir\ue 1o learn about the YVertical Setup controls.

Help Topics: TD55000 Series Oscilloscopes HE

Cantents | Inde | Find |

Click  topic. and then dlick Display. Or olick anather tab, such a5 Indsx.

Select Contents and Index in the Help menu to T

access any topic in the help system. Select the [2) ‘Vihats ew i the TDG5000
i i : i [2) Specificatiors
topic, and then click the Display button in the et e

dialog box. @ ccesmoies
@ Front Panel
@ Screen Interfacs
@ Howto ?
@ Open Deskiop
@ Side Panels
@ Reference Irformation

Cose | Rint. | Cancel |

Bl Overview X]

Help Topics|  Eack Options | ActiveEdit Close Hinimize

Vertical Setup Control Window

Access this control window from the Wertical menu Yertical Setup command, or the Yert toolbar
button.

Overview Y Display Y Postion& Seale Y Dffset ..
1

Catrcl Windo Cecmics

Use these cortrols to set the vertical parameters for live (1 Help Topics Back Options Close hiniEe
each channel are independent; usa the tabs &t the top of tl — — — — —
c=nalyolhwertiokehaims Vertical Position & Scale
For more information on a control, click one of the highlight _ —
Ovenview Y Display Y Positio| & Scale Oifset NP

Position & Scale B

Termination -

Paosition [* ToUse
L]

Fosiion
[

Use the F{asition control to set th|: vertical postion of the waveform on
the scree|1. Use the Scale cortr || window to control the vertical scale
of the wi[veform. Click the contt iz to map them to the multipurpose
knobs, 21|d uss the knobs ta chi|wge the wavetarms.

Click an outlined control shown in the help
window to receive more specific information
about the control.

Behavio|

Each waleform has ts own wei|ical position cortrol. The control
increase | or decreases the ver|cal position of the waveform

0.2 divisi | s (002 divisions witt| FINE control). Increasing the position
walug of [ weavetorm moves tz waveform up, and decreasing the

Display Offset  Invert Channel Cq posttion 1| oves the waveform dfwn
Each wavsform also bas its own s[sical scale control. Fi|r & signal with & constant
Wihat do you want to do next? amplitude, increasing the scale cafses the waveform to ¢|pear smaller. Decreasing the scale

causes the waveform to appear 13| ger.
For channel waveforms, the scale[setting controls the ve [ical size of the acquisition window:
as well as the display scale. The r|nge and resalution of-|1e scale value depends on the

C||Ck a tab in a he|p WindOW to navigate afcheu nrobes and on anv gther [xternal factors youm |y have specified
betWeen the OVerVieW and SpeCifiC tOpiCS, Tip Uise the dedioated knob on the frort panel o cont i the postion and scale of the

selected waveform.

_I‘.—..].‘ Ao A o aa LILI

Click the Minimize button in a help window to
move help out of the way so you can
operate the oscilloscope. Click the Restore
Help button to see the last help topic again.
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To Use the Oscilloscope I/0

On the Front Panel

Probe compensator output to
compensate and deskew probes.

Auxiliary input

Channel inputs

On the Left Side Panel

USB connector for mouse, keyboard, or other
peripherals

PS-2 connectors for mouse and keyboard

Upper SVGA port to connect a monitor for
dual-monitor operation

Lower VGA port to replicate the oscilloscope display
on an external monitor

Parallel port (Centronics) to
connect printer or other device

GPIB port to connect to controller
RJ-45 connector to connect to network

COMT1 serial port

Miniature phone jacks for microphone
input and line input and output

Game controller port

On the Rear Panel

Trigger signal output

www.valuetronics.com

—— Floppy disk drive

0'0

~~—— CDROM drive on the side of
the oscilloscope; press the
button on the cover to open the
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(4-channel models only)
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